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Smooth Transition from Autodesk
Eagle PCB to Altium Designer Develop

For the purpose of this migration guide we are going to focus on importing Eagle PCB Designs, if you require other files

migrated, please refer to their specific guide.

Legacy Translation

Before You Start to Import

This guide will show you how to import data from your legacy system into Altium Designer Develop. What it will not ask
is “why do you want to do it?” Customers frequently ask about data import facilities before we go forward however, we

need to ask ourselves why.

We have 20 years of data, and | don’t
want to leave it behind.

« Does the data include all necessary information to
create a robust representation within Altium?

* s it easier to “draw a line in the sand” and start new
designs in the new system rather than re-work the
imported data to make it usable?

We have some ‘golden’ designs that
we need to bring into Altium Designer
Develop so that we can up-issue them.

« How do you plan to verify the imported data?

« How much re-work is going to be allowed after
importing?

« Do you need to take advantage of additional features
of Altium once imported and how do you plan to
achieve this?

Our service bureau doesn’t use Altium
but they can import Altium data. Our
Altium system can import their data,
is this a reliable way to pass designs
between our companies?

e How do you maintain library integrity?

Who has design authority?

e How do you plan to verify the data?

We have a library of trusted parts which
we'd like to bring into Altium.

* Are there any exotic parts that you may have trouble
representing within Altium?

o Do you need to add Altium-specific features (like 3D
models) for every part?

e How much redundancy, duplication,17 and error is
present in your library?

So, after considering these points you should read on if you still wish to import your legacy data into Altium.

Altlum.
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Preparing to Migrate Your Legacy Data

Never forget that migration of data follows the “garbage in.... more garbage out” principle. So, we need to consider four
distinct phases of the process, this is best shown in the flow diagram below: -

1. Prepare original data
e Check content
e Remove redundant or confusing data

o Verify integrity

4. Post import
o Add Altium-specific objects
e Tidy up

e Final integrity check

2. Export data

e Save data in a format suitable for
import into Altium Designer Develop

3. Import data
e Save «raw» imported data

o Integrity check

Step 1: Prepare Original Data - Pre-Translation Tidy Up

It is prudent to clean and tidy your design within your legacy system before trying to export. We've put together a

checklist to help you:

Schematic considerations

« Does this design have single pin components
representing power objects?

« Connectors are represented as one-gate-per-pin
with over 256 “gates”

« Keep a note of the ambiguous connectivity in the
design (For example - multifunctional pins, hidden
pins, or implicit connections).

Altlum.

Make sure to understand which nets in the design
are local(defined at the document level) in nature.

Do the schematic symbols call up the correct PCB
footprints?

Does the schematic match the PCB?

www.altium.com
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PCB considerations

* Alarge number of graphical objects like mechanical
drawing or non-ECO-registered drawing primitives
need to have assigned in the documentation layers.

* Make a note if the design has star point earth.

« Deliberate DRC violations (For example, allowed
short circuits and net-ties).

* Objects extending beyond the environment

» Knowledge of correct PCB layer assignment is
required in order to map the imported layers with
existing layers in Altium Designer Develop.

o Do the auto-named nets match with the schematic?

Step 2: Save Data in a Suitable Format

Supported Version and File Formats

Library considerations
e Schematic symbols matching with PCB footprints

e Correct supply chain information and BoM
parameters

e Associated 3D models cannot be imported for eagle-
based libraries and one can import the respective
STEP models in Altium later on.

o Correct representation of custom pads, copper
shapes, solder mask and resist.

The following table details the versions of all Eagle design formats that can be migrated into Altium Designer Develop.
Note that this list is updated all of the time, so please check with us for specific systems and versions before

undertaking migration.

TYPE SYSTEM
PCB Eagle
SCH Eagle
LIB Eagle

VERSION FORMAT
6.4.0 (*BRD)
6.4.0 (*SCH)
6.4.0 (*LBR)

Altium Designer Develop’s EAGLE Importer is able to import EAGLE design files saved with EAGLE version 6.4.0 (or
later). These are XML-format in nature — EAGLE binary-format design files cannot be imported directly using the EAGLE
Importer. For these older, binary version design files, it is advised to save them in this later (XML) format, through your
EAGLE software, before attempting to import them into Altium Designer Develop.

PCB files translate as follows:

« Eagle PCB Design files (*.brd) translate to Altium Designer Develop PCB files (*PcbDoc).

« Eagle SCH Design files (*sch) translate to Altium Designer Develop PCB files (*SchDoc).

« Eagle Library Design Files (*lbr) translate to Altium Designer Develop PCB Libraries and Altium Designer Develop

Schematic Libraries (*PcbLib & *SchLib).

Altlum.
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Step 3: Import Data into Altium

Using the Import Wizard for Eagle Design Files Import

Select Type of Files to Import

The Import Wizard can be launched from the Altium
Designer Develop File menu. Choose the EAGLE Projects
and Designs from the list of file types as shown in the Select the type of files you wish to import from the list below,
screenshot below. On the “Importing Eagle Design Files”
screen, click the Add button to choose the Eagle design
files. Multiple files can be translated at the same time.
Step-by-step instructions on how to use the Import
Wizard are to follow.

Cancel

Starting the Import Wizard for Eagle Design files

NOTE:
You can also drag your Eagle Design Files into Altium Designer Develop’s Projects Panel, this will
automatically launch the wizard in Eagle Import mode.

Step-by-Step Import Instructions on Importing
Eagle Design files.

e Start the Import Wizard with File » Import
Wizard

Import Wizard

rd will help you convert your files from other vendaors to Altium Designer

Cancel

A”lllm www.altium.com
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e Select Type of Files to Import—Eagle Projects and Import Wizard

DeSlgnS Select Type of Files to Import

Select the type of fi U wish to import from the list below.

.alg)

nd Libraries Files i ircuitMaker User Librari
aries Files

nd Libraries
nd Library Files
igns and Libraries Files
nd Libraries Files
esign Files

Cancel

EAGLE Import Wizard o Add the file(s) to be translated. In this case,
‘MKR1000.brd" and ‘MKR1000.sch’ have been used.

Importing EAGLE Design Files
LE design files to import.

cb design archive {.brd)
ematic de archive {sch)

Remove

Cancel

NOTE:

You can add as many .brd and .sch files at this point, however, if you add files of a different file
name, separate projects will be created. Once you have chosen your design files, the next screen
will allow you to import any library files you have.

Alt'"m www.altium.com
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Using the ‘Reporting Options’ page map the layers for EAGLE Import Wizard

the PCB by assigning a suitable layer type and layer

Reporting Options

name to be Signal/Solder/Paste/Silkscreen/Mechanical e

Qutput Projects

R he output project structure and sp
the files.

ngs
~ Log All Errors

ettings

Generate 3D body

Schematic settings

lgnore document templates

~ Hide default sheet template

Library settings

e Use the ‘Output Project Structure’ page to enable
or disable the settings for logging all errors, all
warnings, and events respectively. You can also set
up Schematic Settings here.

EAGLE Import Wizard

y the output directory to

tkeepout;tDo

ot translate hidden net names

Cancel

A”lllm www.altium.com
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* A preview of the files being translated and their EAGLE Import W
output directories are then shown. You can change
the main output directory at this point if desired.

Executing Import Process

The imported structure

Qutput Directory: Jm-ufermce"J_

Qutput Structure

Cancel

EAGLE Impart Wizard o Click the final Next button and the Import Wizard will
take care of the rest.

Altium Designer i to import the selected libraries and designs.

Processing Project: MK

brd

-reference?

o Congratulations, your design has now been imported
into Altium Designer Develop! Follow the Post Import
Tidy Up checks to ensure the design has been fully
checked and verified.

Alt'"m www.altium.com
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NOTE:

In case the imported text on schematics is inverted after design import, simply click on the gear
button at the top right corner and Preferences>Schematic>Graphical Editing disable the option
‘Display Strings as Rotated’. An example is shown above.

Alt'"m www.altium.com
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Step 4: Post Import Tidy Up

We've put together a verification checklist for you:-

Physical check
« View » Fit Document

* Board shape and cutouts

Electrical check

e Netlist

Rules
e Have all rules been imported
e DRC check

« Check settings for polygons - Island removal, min
primitive size

« Thermal reliefs, direct connect
« Check power plane settings

« Power plane Pull-back

e Solder mask, Paste mask rules
+ Via Tenting

+ Testpoint assignments

Reference Tech-Doc - Post Import Consideration

Altlum.
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Power check

¢ Nets
e Planes
e Polygons

Documentation check
o Layers
e Text/Strings

¢ Legends

PCB reports
e Number of components/nets

e All nets routed

www.altium.com
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Getting Help

Main article: Documentation and Help

The best way to learn is through doing, Altium and
Altium Designer Develop provide a number of ways to
help you do that:

e Press F1 with cursor over any object, editor, panel,
menu entry, or button to open a brief description in
your web browser

e Use shortcut Shift+F1 while running a command for a
list of shortcuts you can use in that command.

¢ Altium Designer Shortcut Keys

e Search the Altium Documentation, on the Altium
website.

e Visit the Video Library where you can watch over 150
short training videos, each detailing the exact steps
needed to complete a task.

e Activating & Managing Your Altium 365 Workspace

See Also
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Image illustrating pressing Shift+F1 during active
interactive routing command

Below are references to other articles and tutorials in the Altium Designer Develop Documentation Library that talk more
about the conceptual information as well as walk you through specific tasks. Remember, you can also browse through
the Help contents, and use F1 and What'’s This at any time in a dialog for more details.

e For more PCB project options, refer to the tutorial, A Complete Design Walkthrough with Altium Designer Develop.

o For alook at the basics of creating components, read A Look at Creating Library Components.

o For a tutorial that steps you through all the basics of editing multiple objects, take a look at Schematic Placement

and Editing Techniques in Altium Designer Develop.

Project Window | Help
Mew in Altium Designer Develop
Exploring Altium Designer Develop
Shortcut Keys
User Forums

About...

Altium, Inc. - Angelus

Altlum.

A great place to start your journey through all the

new possibilities with your Altium Designer Develop
installation. On the top left of Altium Designer Develop
you can find the Help » Exploring Altium Designer
Develop link

From here, you can easily access the Documentation
where the “Getting Familiar with the Altium Design
Environment” category will ease your beginning into
using Altium.

www.altium.com


https://www.altium.com/documentation/readme
https://www.altium.com/documentation/altium-designer/shortcut-keys
https://www.altium.com/documentation/altium-designer
https://www.altium.com/documentation/altium-designer
https://altiumvideos.live.altium.com/
https://www.altium.com/documentation/altium-365/workspace-activation-management
https://www.altium.com/documentation/altium-designer/tutorial
https://www.altium.com/documentation/altium-designer/creating-file-based-library-components
https://www.altium.com/documentation/altium-designer/schematic-placement-editing-techniques
https://www.altium.com/documentation/altium-designer/schematic-placement-editing-techniques
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Contact

Website
www.altium.com

Phone: +1 858-864-1500

Altlum.

Head Office

Address:
4225 Executive Square, Suite 800,
La Jolla, CA 92037
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